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1 Document aim and typography

1 Document aim and typography

This document describes the setup and use of the NanoLib library and contains a reference to all classes
and functions for programming your own control software for Nanotec controllers. Before using the product,
please note the font styles and typefaces that encode this document.

Underlined text marks a cross reference or hyperlink.

■ Example 1: For exact instructions on the NanoLibAccessor, see Setup.
■ Example 2: Install the Ixxat driver and connect the CAN-to-USB adapter.

Italic text means: This is a named object, a menu path / item, a tab / file name or (if necessary) an
expression in a foreign language.

■ Example 1: Select File > New > Blank Document.
■ Example 2: Open the Tool tab and select Comment.
■ Example 3: In principle, this document distinguishes between:

□ User (= Nutzer; usuario; utente [pt.]; utilisateur; utente [it.] etc.).
□ Third-party user (= Drittnutzer; tercero usuario; terceiro utente; tiers utilisateur; terzo utente etc.).
□ End user (= Endnutzer; usuario final; utente final; utilisateur final; utente finale etc.).

Courier marks code blocks or programming commands.

■ Example 1: Via Bash, call sudo make install to copy shared objects; then call ldconfig.
■ Example 2: Use the following NanoLibAccessor function to change the logging level in NanoLib:

//
        ***** C++ variant *****
 void setLoggingLevel(LogLevel level);

Bold text emphasizes individual words of critical importance. Alternatively, bracketed exclamation marks
emphasize the critical(!) importance.

■ Example 1: Protect yourself, others and your equipment. Follow our general safety notes that are
generally applicable to all Nanotec products.

■ Example 2: For your own protection, also follow our specific safety notes that apply to this specific
product.

The verb to co-click means a click via secondary mouse key to open a context menu etc.

■ Example 1: Co-click on the file, select Rename, and rename the file.
■ Example 2: To check the properties, co-click on the file and select Properties.
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2 Before you start

2 Before you start

Before you start using NanoLib, you need to prepare your PC and inform yourself about the intended use
and the library limitations.

2.1 System and hardware requirements

NanoLib is executable only under 64-bit operating systems. It supports all Nanotec products with CANopen,
Modbus RTU (including USB via virtual comport) and Modbus TCP. Note: Follow valid OEM instructions to
set the latency to the minimun value possible if you encounter problems when using an FTDI-based USB
adapter.

NanoLib 64-bit OS requirements Fieldbus adapters / cables

v 0.7.1 ■ Windows 10: with Visual Studio;
VC++ runtimes x64; .NET
Desktop Development

■ CANopen:

□ IXXAT USB-to-CAN V2
□ Nanotec ZK-USB-CAN-1

■ Modbus RTU:

□ Nanotec ZK-USB-RS485-1 or
equivalent USB-RS485 adapter

□ USB cable via virtual comport (VCP)

■ Modbus TCP:

□ Ethernet cable according to product
datasheet.

2.2 Intended use and audience

NanoLib is a program library for the operation of, and communication with, Nanotec controllers. NanoLib
is intended to be used as a software component in a wide range of industrial applications where Nanotec
controllers are installed.

The underlying operating system and the used hardware (PC) on which NanoLib is intended to run do not
provide real-time capability. NanoLib can therefore not be used for applications that require synchronous
multi-axis movement or are generally time-sensitive.

Under no circumstances may this Nanotec product be integrated as a safety component in a product or sys-
tem. All products containing a component manufactured by Nanotec must, upon delivery to the end user, be
provided with corresponding warning notices and instructions for safe use and safe operation. All warning
notices provided by Nanotec must be passed on directly to the end user.

NanoLib solely and exclusively addresses duly skilled programmers in industrial application scenarios.

2.3 Scope of delivery and warranty

NanoLib comes as a *.zip folder from our download website for either EMEA / APAC or AMERICA. Duly store
and unzip your download before setup. The NanoLib package contains:

■ Interface classes as source code (API)
■ Libraries that facilitate the communication

via the fieldbus: nanolibm_canopen.dll,
nanolibm_modbus.dll

■ Core functions as libraries in binary format:
nanolib_csharp

■ Example project: NanolibExample.sln (Visual Stu-
dio project) and NanolibExample (main file)

For scope of warranty, please observe our terms and conditions for either EMEA / APAC or AMERICA, and
strictly follow all license terms. Note: Nanotec is not liable for faulty or undue quality, handling, installation,
operation, use, and maintenance of third-party equipment! For due safety, always follow valid OEM instruc-
tions.
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3 The NanoLib architecture

3 The NanoLib architecture

NanoLib's modular software structure lets you organize freely customizable motor controller / fieldbus func-
tions around a strictly preconfigured core. NanoLib contains the following modules:

User interface (API) NanoLib core Communication libraries

Interface and helper classes which

■ grant access to your con-
troller's OD (object dictionary)

■ are based on the NanoLib core
functionalities.

Libraries which

■ implement the API functionality
■ interact with bus libraries.

Fieldbus-specific libraries which

■ serve as interface between
NanoLib core and bus hard-
ware.

3.1 User interface

The user interface consists of header interface files you can use to access the controller parameters. The
user interface classes as described in the Classes / functions reference allow you to:

■ Connect to the hardware (fieldbus adapter).
■ Connect to the controller device.
■ Access the OD of the device, to read/write the controller parameters.

3.2 NanoLib core

The NanoLib core comes with the library nanolib_csharp.dll. It implements the user interface functionality
and is repsonsible for:

■ Loading and managing the communication libraries.
■ Providing the user interface functionalities in the NanoLibAccessor. This communication entry point

defines a set of operations you can execute on the NanoLib core and communication libraries.

3.3 Communication libraries

The communication libraries provided by NanoLib (nanolibm_canopen.dll, nanolibm_modbus.dll) serve
as hardware abstraction layer between core and controller. The core loads these libraries at startup time
from the designated project folder and uses them to establish communication with the controller via the cor-
responding protocol.
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4 Getting started

4 Getting started

Read and learn how to set up NanoLib for your operating system duly and connect your hardware as
needed.

4.1 Prepare your system

Prepare the PC along your OS.

■ In Windows: Install the latest Microsoft Visual Studio; .NET Desktop Development.

4.2 Install the adapter driver for Windows

Only after due driver installation, you may use the IXXAT USB-to-CAN V2 adapter. Note: All other supported
adapters do not require a driver installation Refer to the product manual of USB drives, to find out how to
activate the virtual comport (VCP).

1. Download and install the IXXAT VCI 4 driver for Windows from www.ixxat.com.

2. Connect the IXXAT USB-to-CAN V2 compact adapter to the PC via USB.

3. Via Device Manager: Check if both driver and adapter are duly installed/recognized.

4.3 Connect your hardware

To be able to run a NanoLib project, connect a compatible Nanotec controller to the PC using your adapter.

1. Connect your adapter to the controller using a suitable cable.

2. Connect the adapter to the PC according to the adapter data sheet.

3. Power on the controller using a suitable power supply.

4. If needed, change the communication settings of the Nanotec controller according to the instructions in
the product manual.

4.4 Load NanoLib

For a first start with quick-and-easy basics, you may (but must not) use our example project.

1. According to your region and needs: Download NanoLib from our website for either EMEA / APAC or
AMERICA.

2. Unzip all files and folders from the NanoLib download package.

Select one option:

■ For quick-and easy basics: See Starting the example project.
■ For advanced customizing in Windows: See Creating your own project.
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5 Starting the example project

5 Starting the example project

With NanoLib duly loaded, the example project shows you through NanoLib usage with a Nanotec controller.
Note: For each step, comments in the provided example code explain the functions used. The example
project NanolibExample.sln consists of:

■ Nanolib_Example.cs (main file)
■ NanolibHelper.cs (helper class for wrapping the NanoLib accessor)

In Windows with Visual Studio

1. Open the NanolibExample.sln file.
2. Open the Nanolib_Example.cs(main file).
3. Build the project (this will restore the nuget package).
4. Close and reopen Visual Studio.
5. Open the Nanolib_Example.cs again.
6. Compile and run the example code.

The example demonstrates the typical workflow for working with a controller:

1. Check the PC for connected hardware (adapters) and list them.

2. Establish connection to an adapter.

3. Scan the bus for connected controller devices.

4. Connect to a device.

5. Read/write from/to the object dictionary of the controller (examples provided in the code).

6. Close the connection to the device.

7. Close the connection to the adapter.
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6 Creating your own project

6 Creating your own project

Create, compile and run your own Windows project to use NanoLib.

6.1 Prepare the NuGet repository

1. Create a folder for local repository, say, C:\NugetRepo.

2. Unzip all files and folders from nanolib_csharp_win_###.zip.

3. From that NanoLib unzip: Copy Nanolib.####.nupkg to the local repository.

4. Add the repository to Visual Studio Tools > NuGet Package Manager > Package Sources > Add > Add
your directory.

6.2 Create a new project

Before creating a project, make package.config your default NuGet package format.

1. Open Visual Studio > Tools > Options > NuGet Package Manager > General.

2. In Package Management: Select package.config for default format.

3. Only now, go to Open Visual Studio > Home.

4. Select Create new project.

5. For project type: Select Console App (.NET Framework) - C# and Next.

6. Name the project, say, NanolibTest and set its location.

7. Select Framework > .NET Framework 4.7.2. and Create.

8. To add your Nanolib NuGet Package: Co-click your project > Manage NuGet Packages... > Browse >
Nanolib.

9. Select the latest version and Install. Note: If you see no NanoLib package, prepare your NuGet repository
(see above).

10.For a x64 target platform: Co-click your project > Properties > Build > Platform target: x64.

6.3 Build your project

Build your NanoLib project in MS Visual Studio.

1. Open the main ("Program.cs" in this example) and replace the text with the following code:

class Program
{
        static void Main(string[] args)
        {
            Nlc.NanoLibAccessor accessor = Nlc.Nanolib.getNanoLibAccessor();  
      
        }
 }

2. Select Build > Build solution.
→ In the compile output window, there should be no error:

========== Build: 1 succeeded, 0 failed, 0 up-to-date, 0 skipped ==========
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7 Classes / functions reference

7 Classes / functions reference

Find here a list of the classes of NanoLib's User Interface and their member functions. The typical descript-
ion of a function includes a short introduction, the function definition and a parameter / return list:

ExampleFunction ()

Tells you briefly what the function does.

public BusHardwareId(string busHardware_, string protocol_, string
 hardwareSpecifier_, string name_)

Parameters param_a Additional comment if needed.

param_b

Returns ResultVoid Additional comment if needed.

7.1 NanoLibAccessor

Interface class used as entry point to the NanoLib. A typical workflow looks like this:

1. Start by scanning for hardware with NanoLibAccessor.listAvailableBusHardware ().
2. Set the communication settings with BusHardwareOptions ().
3. Open the hardware connection with NanoLibAccessor.openBusHardwareWithProtocol ().
4. Scan the bus for connected devices with NanoLibAccessor.scanDevices ().
5. Add a device with NanoLibAccessor.addDevice ().
6. Connect to the device with NanoLibAccessor.connectDevice ().
7. After finishing the operation, disconnect the device with NanoLibAccessor.disconnectDevice ().
8. Remove the device with NanoLibAccessor.removeDevice ().
9. Close the hardware connection with NanoLibAccessor.closeBusHardware ().
10.Familiarize yourself with the class's following public member functions:

listAvailableBusHardware ()

Use this function to list the available fieldbus hardware.

virtual ResultBusHwIds listAvailableBusHardware()

Returns ResultBusHwIds Delivers a fieldbus ID array.

openBusHardwareWithProtocol ()

Use this function to establish connection with a bus hardware.

virtual ResultVoid openBusHardwareWithProtocol(BusHardwareId busHwId,
 BusHardwareOptions busHwOpt)

Parameters busHwId Specifies the fieldbus to open.

busHwOpt Specifies fieldbus opening options.

Returns ResultVoid Confirms the execution of a void function.

getProtocolSpecificAccessor ()

Use this function to get the protocol-specific accessor object.

virtual ResultVoid getProtocolSpecificAccessor(BusHardwareId busHwId)

Parameters busHwId Specifies the fieldbus to get the accessor for.
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7 Classes / functions reference

Returns ResultVoid Confirms the execution of a void function.

setBusState ()

Use this function to set the bus-protocol-specific state.

virtual ResultVoid setBusState(BusHardwareId busHwId, string state)

Parameters busHwId Specifies the fieldbus to open.

state Assigns a bus-specific state as a string value.

Returns ResultVoid Confirms the execution of a void function.

scanDevices ()

Use this function to scan for devices in the network.

virtual ResultDeviceIds scanDevices(BusHardwareId busHwId, NlcScanBusCallback
 callback)

Parameters busHwId Specifies the fieldbus to scan.

callback NlcScanBusCallback progress tracer.

Returns ResultDeviceIds Delivers a device ID array.

IOError Informs that a device is not found.

addDevice ()

Use this function to add a bus device described by deviceId to the NanoLib internal device list and return
deviceHandle for it.

virtual ResultDeviceHandle addDevice(DeviceId deviceId)

Parameters deviceId Specifies the device to add to the list.

Returns ResultDeviceHandle Delivers a device handle.

connectDevice ()

Use this function to establish connection with a device using deviceHandle.

virtual ResultVoid connectDevice( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should connect to.

Returns ResultVoid Confirms the execution of a void function.

IOError Informs that a device is not found.

getDeviceName ()

Use this function to get the device name using deviceHandle.

virtual ResultString getDeviceName( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the name
for.

Returns ResultString Delivers a device name as a string.
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7 Classes / functions reference

getDeviceProductCode ()

Use this function to get the device product code using deviceHandle.

virtual ResultInt getDeviceProductCode( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the product
code for.

Returns ResultInt Delivers the product code as an integer.

getDeviceVendorId ()

Use this function to get the device vendor ID using deviceHandle.

virtual ResultInt getDeviceVendorId( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the vendor
id for.

Returns ResultInt Delivers the product code as an integer.

getDeviceId ()

Use this function to get the device ID of a specific device from the NanoLib internal list.

virtual ResultDeviceId getDeviceId( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the device
ID for.

Returns ResultDeviceId Delivers a device ID.

getDeviceIds ()

Use this function to get the device ID of all devices from the NanoLib internal list.

virtual ResultDeviceIds getDeviceIds()

Returns ResultDeviceIds Delivers a device ID list.

getDeviceUid ()

Use this function to get the device ID of a specific device from the NanoLib internal list.

virtual ResultDeviceId getDeviceUid( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the device
ID for.

Returns ResultDeviceId Delivers a device ID.

getDeviceSerialNumber ()

Use this function to get the serial of a device from the NanoLib internal list.

virtual ResultString getDeviceSerialNumber(Nlc.DeviceHandledeviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the serial
number for.

Returns ResultString Delivers a device name as a string.
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7 Classes / functions reference

getDeviceBootloaderBuildId ()

Use this function to get a bus device's bootloader build ID via device handle.

virtual ResultString getDeviceBootloaderBuildId( Nlc.DeviceHandle 
 deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the
bootloader build ID for.

Returns ResultString Delivers a device name as a string.

getDeviceFirmwareBuildId ()

Use this function to get a bus device's firmware build ID via device handle.

virtual ResultString getDeviceFirmwareBuildId( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the
firmware build ID for.

Returns ResultString Delivers a device name as a string.

getDeviceHardwareVersion ()

Use this function to get a bus device's hardware version via device handle.

virtual ResultString getDeviceHardwareVersion( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the
hardware version for.

Returns ResultString Delivers a device name as a string.

getDeviceState ()

Use this function to get the device-protocol-specific state.

virtual ResultString getDeviceState( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the state
for.

Returns ResultString Delivers a device name as a string.

setDeviceState ()

Use this function to set the device-protocol-specific state.

virtual ResultVoid setDeviceState( Nlc.DeviceHandle  deviceHandle, string
 state)

Parameters deviceHandle Specifies which bus device NanoLib should set the state
for.

state Assigns a bus-specific state as a string value.

Returns ResultVoid Confirms the execution of a void function.
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7 Classes / functions reference

getConnectionState ()

Use this function to get the connection state of a specific device using deviceHandle.

virtual ResultConnectionState getConnectionState( Nlc.DeviceHandle 
 deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should set the state
for.

Returns ResultConnectionState Delivers a connection state.

assignObjectDictionary ()

Use this function to assign an object dictionary to deviceHandle.

virtual ResultObjectDictionary assignObjectDictionary( Nlc.DeviceHandle 
 deviceHandle, ObjectDictionary objectDictionary)

Parameters deviceHandle Specifies which bus device NanoLib should assign the OD
to.

objectDictionary

Returns ResultObjectDictionary Shows the properties of an object dictionary.

getAssignedObjectDictionary ()

Use this function to get the object dictionary assigned to a device using deviceHandle.

virtual ResultObjectDictionary getAssignedObjectDictionary( Nlc.DeviceHandle 
 deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should get the
assigned OD for.

Returns ResultObjectDictionary Shows the properties of an object dictionary.

objectDictionaryLibrary ()

This function returns a reference to the object dictionary library.

virtual OdLibrary objectDictionaryLibrary()

Returns OdLibrary& Shows which object dictionary is assigned to what library.

setLoggingLevel ()

Use this function to set the needed logging level and limit the console output of the library.

virtual void setLoggingLevel(LogLevel level)

Parameters level The following levels are possible:

0 = Off Switches off the logging entirely.

1 = Trace Lowest level, logs everything (expect huge logfiles).

2 = Debug Logs only debug information.

3 = Info Default level.

4 = Warn Message on recoverable problems.

5 = Error Highest level, only for messages followed very likely by a progam exit.
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7 Classes / functions reference

readNumber ()

Use this function to read a numeric value from the controller object dictionary.

virtual ResultInt readNumber( Nlc.DeviceHandle  deviceHandle,  Nlc.OdIndex 
 odIndex)

Parameters deviceHandle Specifies which bus device NanoLib should read from.

odIndex Specifies the (sub-) index to read from.

Returns ResultInt Delivers an uninterpreted numeric value (can be signed,
unsigned, fix16.16 bit values).

readNumberArray ()

Use this function to read numeric arrays from the object dictionary.

virtual ResultArrayInt readNumberArray( Nlc.DeviceHandle  deviceHandle, ushort
 index)

Parameters deviceHandle Specifies which bus device NanoLib should read from.

index Array object index..

Returns ResultArrayInt Delivers an array of integers.

readBytes ()

Use this function to read arbitrary bytes (domain object data) from the object dictionary.

virtual ResultArrayByte readBytes( Nlc.DeviceHandle  deviceHandle, 
 Nlc.OdIndex  odIndex)

Parameters deviceHandle Specifies which bus device NanoLib should read from.

odIndex Specifies the (sub-) index to read from.

Returns ResultArrayByte Delivers an array of bytes.

readString ()

Use this function to read strings from the object directory.

virtual ResultString readString( Nlc.DeviceHandle  deviceHandle,  Nlc.OdIndex 
 odIndex)

Parameters deviceHandle Specifies which bus device NanoLib should read from.

odIndex Specifies the (sub-) index to read from.

Returns ResultString Delivers a device name as a string.

writeNumber ()

Use this function to write numeric values to the object directory.

virtual ResultVoid writeNumber( Nlc.DeviceHandle  deviceHandle, long value, 
 Nlc.OdIndex  odIndex, uint bitLength)

Parameters deviceHandle Specifies which bus device NanoLib should write to.

value The uninterpreted value (can be signed, unsigned,
fix16.16).

odIndex Specifies the (sub-) index to read from.

bitLength Length in bit.
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7 Classes / functions reference

Returns ResultVoid Confirms the execution of a void function.

writeBytes ()

Use this function to write arbitrary bytes (domain object data) to the object directory.

virtual ResultVoid writeBytes( Nlc.DeviceHandle  deviceHandle, ByteVector
 data,  Nlc.OdIndex  odIndex)

Parameters deviceHandle Specifies which bus device NanoLib should write to.

data Byte vector / array.

odIndex Specifies the (sub-) index to read from.

Returns ResultVoid Confirms the execution of a void function.

firmwareUpload ()

Use this function to update your controller firmware.

virtual ResultVoid firmwareUpload( Nlc.DeviceHandle  deviceHandle, ByteVector
 fwData, NlcDataTransferCallback callback)

Parameters deviceHandle Specifies which bus device NanoLib should update.

fwData Array containing firmware data.

NlcDataTransferCallback A data progress tracer.

Returns ResultVoid Confirms the execution of a void function.

firmwareUploadFromFile ()

Use this function to update your controller firmware by uploading the firmware file.

virtual ResultVoid firmwareUploadFromFile( Nlc.DeviceHandle  deviceHandle,
 string absoluteFilePath, NlcDataTransferCallback callback)

Parameters deviceHandle Specifies which bus device NanoLib should update.

absoluteFilePath Path to file containing firmware data (string).

NlcDataTransferCallback A data progress tracer.

Returns ResultVoid Confirms the execution of a void function.

bootloaderUpload ()

Use this function to update your controller bootloader.

virtual ResultVoid bootloaderUpload( Nlc.DeviceHandle  deviceHandle,
 ByteVector btData, NlcDataTransferCallback callback)

Parameters deviceHandle Specifies which bus device NanoLib should update.

btData Array containing bootloader data.

NlcDataTransferCallback A data progress tracer.

Returns ResultVoid Confirms the execution of a void function.

bootloaderUploadFromFile ()

Use this function to update your controller bootloader by uploading the bootloader file.

virtual ResultVoid bootloaderUploadFromFile( Nlc.DeviceHandle  deviceHandle,
 string bootloaderAbsoluteFilePath, NlcDataTransferCallback callback)
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7 Classes / functions reference

Parameters deviceHandle Specifies which bus device NanoLib should update.

bootloaderAbsoluteFilePath Path to file containing bootloader data (string)

NlcDataTransferCallback A data progress tracer.

Returns ResultVoid Confirms the execution of a void function.

bootloaderFirmwareUpload ()

Use this function to update your controller bootloader and firmware.

virtual ResultVoid bootloaderFirmwareUploadFromFile( Nlc.DeviceHandle 
 deviceHandle, string bootloaderAbsoluteFilePath, string absoluteFilePath,
 NlcDataTransferCallback callback)

Parameters deviceHandle Specifies which bus device NanoLib should update.

btData Array containing bootloader data.

fwData Array containing firmware data.

NlcDataTransferCallback A data progress tracer.

Returns ResultVoid Confirms the execution of a void function.

bootloaderFirmwareUploadFromFile ()

Use this function to update your controller bootloader and firmware by uploading the files.

virtual ResultVoid bootloaderFirmwareUploadFromFile( Nlc.DeviceHandle 
 deviceHandle, string bootloaderAbsoluteFilePath, string absoluteFilePath,
 NlcDataTransferCallback callback)

Parameters deviceHandle Specifies which bus device NanoLib should update.

bootloaderAbsoluteFilePath Path to file containing bootloader data (string).

absoluteFilePath Path to file containing firmware data (uint8_t).

NlcDataTransferCallback A data progress tracer.

Returns ResultVoid Confirms the execution of a void function.

nanojUpload ()

Use this public function to updload the NanoJ program to your controller.

virtual ResultVoid nanojUpload( Nlc.DeviceHandle  deviceHandle, ByteVector
 vmmData, NlcDataTransferCallback callback)

Parameters deviceHandle Specifies which bus device NanoLib should upload to.

vmmData Array containing NanoJ data.

NlcDataTransferCallback A data progress tracer.

Returns ResultVoid Confirms the execution of a void function.

nanojUploadFromFile ()

Use this public function to updload the NanoJ program to your controller by uploading the file.

virtual ResultVoid nanojUploadFromFile( Nlc.DeviceHandle  deviceHandle, string
 absoluteFilePath, NlcDataTransferCallback callback)

Parameters deviceHandle Specifies which bus device NanoLib should upload to.

absoluteFilePath Path to file containing NanoJ data (string).

NlcDataTransferCallback A data progress tracer.

Version: 1.0.1 / 0.7.1 17



7 Classes / functions reference

Returns ResultVoid Confirms the execution of a void function.

disconnectDevice ()

Use this function to disconnect your device.

virtual ResultVoid disconnectDevice( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should disconnect
from.

Returns ResultVoid Confirms the execution of a void function.

removeDevice ()

Use this function to remove your device from the internal NanoLib device list.

virtual ResultVoid removeDevice( Nlc.DeviceHandle  deviceHandle)

Parameters deviceHandle Specifies which bus device NanoLib should remove from
the list.

Returns ResultVoid Confirms the execution of a void function.

closeBusHardware ()

Use this function to close the connection to your fieldbus hardware.

virtual ResultVoid closeBusHardware(BusHardwareId busHwId)

Parameters busHwId Specifies the fieldbus to close the connection to.

Returns ResultVoid Confirms the execution of a void function.

7.2 BusHardwareId

Use this class to identify a bus hardware one-to-one or to distinguish different bus hardware from each other.
This class, without setter functions to be immutable from creation on, also holds information on:

■ Hardware (= adapter name, network adapter etc.)
■ Bus hardware specifier (= serial port name, MAC

address etc.)

■ Protocol to use (= Modbus TCP, CANopen etc.)
■ Friendly name

BusHardwareId ()

Creates a new bus hardware ID object.

BusHardwareId(string busHardware_, string protocol_,
 string hardwareSpecifier_,
string extraHardwareSpecifier_, string name_)

Parameters busHardware_ Hardware type (= ZK-USB-CAN-1 etc.)

protocol_ Bus communication protocol (= CANopen etc.)

hardwareSpecifier_ The specifier of a hardware (= COM3 etc.)

extraHardwareSpecifier The extra specifier of the hardware (USB location info for
example)

name_ A friendly name (= AdapterName (Port) etc. )
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equals ()

Compares a new bus hardware ID to existing ones.

bool equals(BusHardwareId other)

Parameters other Another object of the same class.

Returns true If both are equal in all values.

false If the values differ.

getBusHardware ()

Reads out the bus hardware string.

string getBusHardware()

Returns string

getHardwareSpecifier ()

Reads out the bus hardware's specifier string (= MAC address etc.).

string getHardwareSpecifier()

Returns string

getName ()

Reads out the bus hardware's friendly name.

string getName()

Returns string

getProtocol ()

Reads out the bus protocol string.

string getProtocol ()

Returns string

toString ()

Reads out the bus hardware ID as a string.

string toString ()

Returns string

7.3 BusHardwareOptions

Find in this class, in a key-value list of strings, all options needed to open a bus hardware.
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BusHardwareOptions () [1/2]

Creates a new bus hardware option object.

BusHardwareOptions()

Use the function void addOption(string key, string value) to add key-value pairs.

BusHardwareOptions () [2/2]

Creates a new bus hardware options object with the key-value map already in place.

BusHardwareOptions(String_String_Map options)

Parameters options A map with options for the bus hardware to operate.

addOption ()

Creates additional keys and values.

void addOption(string key, string value)

Parameters key Example: BAUD_RATE_OPTIONS_NAME

value Example: BAUD_RATE_1000K

equals ()

Compares the BusHardwareOptions to existing ones.

bool equals(BusHardwareOptions other)

Parameters other Another object of the same class.

Returns true If the other object has all of the exact same options.

false If the other object has different keys or values.

getOptions ()

Reads out all added key-value pairs.

String_String_Map getOptions()

Returns string map

toString ()

Reads out all keys / values as a string.

string toString()

Returns string

7.4 BusHwOptionsDefault

This default configuration options class has the following public attributes:

const CanBus canBus = CanBus ()

const Serial serial = Serial ()
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7.5 CanBaudRate

Struct that contains CAN bus baudrates in the following public attributes:

string BAUD_RATE_1000K = "1000k"

string BAUD_RATE_800K = "800k"

string BAUD_RATE_500K = "500k"

string BAUD_RATE_250K = "250k"

string BAUD_RATE_125K = "125k"

string BAUD_RATE_100K = "100k"

string BAUD_RATE_50K = "50k"

string BAUD_RATE_20K = "20k"

string BAUD_RATE_10K = "10k"

string BAUD_RATE_5K = "5k"

7.6 CanBus

Default configuration options class with the following public attributes:

string BAUD_RATE_OPTIONS_NAME = "can adapter baud rate"

const CanBaudRate baudRate = CanBaudRate ()

const Ixxat ixxat = Ixxat ()

7.7 CanOpenNmtService

For the NMT service, this struct contains the CANopen NMT states as string values in the following public
attributes:

string START = "START"

string STOP = "STOP"

string PRE_OPERATIONAL = "PRE_OPERATIONAL"

string RESET = "RESET"

string RESET_COMMUNICATION =
"RESET_COMMUNICATION"

7.8 CanOpenNmtState

This struct contains the CANopen NMT states as string values in the following public attributes:

string STOPPED = "STOPPED"

string PRE_OPERATIONAL = "PRE_OPERATIONAL"

string OPERATIONAL = "OPERATIONAL"

string INITIALIZATION = "INITIALIZATION"

string UNKNOWN = "UNKNOWN"

7.9 Ixxat

This struct holds all information for the IXXAT usb-to-can in the following public attributes:

string ADAPTER_BUS_NUMBER_OPTIONS_NAME = "ixxat
adapter bus number"

const IxxatAdapterBusNumber adapterBusNumber = IxxatAdapterBusNumber ()
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7.10 IxxatAdapterBusNumber

This struct holds the bus number for the IXXAT usb-to-can in the following public attributes:

string BUS_NUMBER_0_DEFAULT = "0"

string BUS_NUMBER_1 = "1"

string BUS_NUMBER_2 = "2"

string BUS_NUMBER_3 = "3"

7.11 DeviceHandle

This class represents a handle for controlling a device on a bus and has the following public member
functions.

DeviceHandle ()

DeviceHandle(DeviceHandle deviceHandle)

Returns ResultVoid

7.12 DeviceId

Use this class (not immutable from creation on) to identify and distinguish devices on a bus:

■ Hardware adapter identifier ■ Device identifier ■ Description

The meaning of device ID / description values depends on the bus. Thus, a CAN bus may use the integer ID.

DeviceId ()

Creates a new device ID object.

DeviceId(BusHardwareId busHardwareId_, uint deviceId_,
 string description_, const extraId_, string const extraStringId_)

Parameters busHardwareId_ Identifier of the bus.

deviceId_ An index; subject to the bus (= CANopen node ID etc.).

description_ A description (maybe empty); subject to the bus.

extraId_ An additional ID (may be empty), meaning is depending on
the bus.

extraStringId_ An additional String Id (may be empty), meaning is
depending on the bus.

equals ()

Compares new to existing objects.

bool equals(DeviceId other)

Returns boolean

getBusHarwareId ()

Reads out the bus hardware ID.

BusHardwareId getBusHardwareId()
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Returns BusHardwareId

getDescription ()

Reads out the device description (maybe unused).

string getDescription()

Returns string

getDeviceId ()

Reads out the device ID (maybe unused).

uint getDeviceId()

Returns unsigned int

toString ()

Reads out the object as a string.

string toString()

Returns string

getExtraId()

Get the extra ID of the device (may be unused).

string toString()

Returns vector extraId_ A vector of the additional extraIds (may be empty), meaning
is depending on the bus.

getExtraStringId()

Get the extra string ID of the device (may be unused).

string etExtraStringId()

Returns string The additional StringId (may be empty), meaning is
depending on the bus.

7.13 ObjectDictionary

This class represents an object dictionary of a controller and has the following public member functions:

getDeviceHandle

virtual ResultDeviceHandle getDeviceHandle()

Returns ResultDeviceHandle

getObject

virtual ResultObjectSubEntry getObject( Nlc.OdIndex  odIndex)
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Returns ResultObjectSubEntry

getObjectEntry

virtual ResultObjectEntry getObjectEntry(ushort index)

Returns ResultObjectEntry

readNumber

virtual ResultInt readNumber( Nlc.OdIndex  odIndex)

Returns ResultInt

readNumberArray

virtual ResultArrayInt readNumberArray(ushort index)

Returns ResultArrayInt

readString

virtual ResultString readString( Nlc.OdIndex  odIndex)

Returns ResultString

readBytes

virtual ResultArrayByte readBytes( Nlc.OdIndex  odIndex)

Returns ResultArrayByte

writeNumber

virtual ResultVoid writeNumber( Nlc.OdIndex  odIndex, long value)

Returns ResultVoid

writeBytes

virtual ResultVoid writeBytes( Nlc.OdIndex  odIndex, ByteVector data)

Returns ResultVoid

7.14 ObjectEntry

This class represents an object entry of the object dictionary

The class has the following public member functions:

getName

Reads out the name of the object.

virtual string getName()
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getPrivate

Checks if the object is private.

virtual bool getPrivate()

getIndex

Reads out the address of the object index.

virtual ushort getIndex()

getDataType

Reads out the data type of the object.

virtual ObjectEntryDataType getDataType()

getObjectCode

Reads out the object code (variable, array etc.).

virtual ObjectCode getObjectCode()

getObjectSaveable

Checks if the object is saveable.

virtual ObjectSaveable getObjectSaveable()

getMaxSubIndex

Reads out the number of subindices supported by this object.

virtual byte getMaxSubIndex()

getSubEntry

virtual ObjectSubEntry getSubEntry(byte subIndex)

See also ObjectSubEntry.

7.15 ObjectSubEntry

Class representing an object sub-entry (subindex) of the object dictionary and has the following public
member functions:

getName

Reads out the name of the subindex.

virtual string getName()

getSubIndex

Reads out the address of the subindex.

virtual byte getSubIndex()
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getDataType

Reads out the data type of the subindex.

virtual ObjectEntryDataType getDataType()

getSdoAccess

Checks if the subindex is accessible via SDO.

virtual ObjectSdoAccessAttribute getSdoAccess()

getPdoAccess

Checks if the subindex is accessible/mappable via PDO.

virtual ObjectPdoAccessAttribute getPdoAccess()

getBitLength

Checks the subindex length.

virtual uint getBitLength()

getDefaultValueAsNumeric

Reads out the default value of the subindex for numeric data types.

virtual ResultInt getDefaultValueAsNumeric(string key)

getDefaultValueAsString

Reads out the default value of the subindex for string data types.

virtual ResultString getDefaultValueAsString(string key)

getDefaultValues

Reads out the default values of the subindex.

virtual String_String_Map getDefaultValues()

readNumber

Reads out the numeric actual value of the subindex.

virtual ResultInt readNumber()

readString

Reads out the string actual value of the subindex.

virtual ResultString readString()
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readBytes

Reads out the actual value of the subindex in bytes.

virtual ResultArrayByte readBytes()

writeNumber

Writes a numeric value in the subindex.

virtual ResultVoid writeNumber(long value)

writeBytes

Writes a value in the subindex in bytes.

virtual ResultVoid writeBytes(ByteVector data)

7.16 OdIndex

Use this class, immutable from creation on, to wrap and locate object directory indices / sub-indices. A de-
vice's OD has up to 65535 (0xFFFF) rows and 255 (0xFF) columns; with gaps between the discontinuous
rows. See the CANopen standard for further details.

OdIndex ()

Creates a new OdIndex object.

OdIndex(ushort index, byte subIndex)

Parameters index From 0 to 65535 (0xFFFF) incl.

subindex From 0 to 255 (0xFF) incl.

getIndex ()

Reads out the index (from 0x0000 to 0xFFFF).

ushort Index { get; }

getSubindex ()

Reads out the sub-index (from 0x00 to 0xFF)

byte SubIndex { get; }

toString ()

Reads out the (sub-) index as a string. The string default 0xIIII:0xSS reads as follows:

■ I = index from 0x0000 to 0xFFFF ■ S = sub-index from 0x00 to 0xFF

std::string nlc::OdIndex::toString () const

string ToString()

Returns 0xIIII:0xSS Default string representation
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7.17 OdLibrary

This class represents an object dictionary library and has the following public member functions:

getObjectDictionaryCount

virtual uint getObjectDictionaryCount()

getObjectDictionary

virtual ResultObjectDictionary getObjectDictionary(uint odIndex)

addObjectDictionaryFromFile

virtual ResultObjectDictionary addObjectDictionaryFromFile(string
 absoluteXmlFilePath) 

addObjectDictionary

virtual ResultObjectDictionary addObjectDictionary(ByteVector odXmlData) 

7.18 OdTypesHelper

In addition to the following public member functions, this class contains custom data types. Note: To check
your custom data types, open public enum ObjectEntryDataType in ObjectEntryDataType.cs.

uintToObjectCode

Converts unsigned integers to object code.

static ObjectCode uintToObjectCode (unsigned int objectCode)

isNumericDataType

Informs if a data type is numeric or not.

static bool isNumericDataType (ObjectEntryDataType dataType)

isDefstructIndex

Informs if an object is a definition structure index or not.

static bool isDefstructIndex (uint16_t typeNum)

isDeftypeIndex

Informs if an object is a definition type index or not.

static bool isDeftypeIndex (uint16_t typeNum)

isComplexDataType

Informs if a data type is complex or not.

static bool isComplexDataType (ObjectEntryDataType dataType)
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uintToObjectEntryDataType

Converts unsigned integers to OD data type.

static ObjectEntryDataType uintToObjectEntryDataType (unsigned int objectData
Type)

objectEntryDataTypeToString

Converts OD data type to string.

static std::string objectEntryDataTypeToString (ObjectEntryDataType odData
Type)

stringToObjectEntryDatatype

Converts std::string to OD data type if possible. Otherwise, returns UNKNOWN_DATATYPE.

static ObjectEntryDataType stringToObjectEntryDatatype (std::string dataType
String)

objectEntryDataTypeBitLength

Informs on bit length of an object entry data type.

static uint32_t objectEntryDataTypeBitLength (ObjectEntryDataType const & data
Type)

7.19 Result classes

Use the "optional" return values of these classes to check if a function call had success or not, and also lo-
cate the fail reasons. On a success, the hasError () function returns false. Via getResult (), you can read out
the result value (depending on the result type, e.g., ResultInt). If your call fails, you can read out the reason
via getError ().

Protected attributes string errorString

NlcErrorCode errorCode

uint32_t exErrorCode

Also, this class has the following public member functions:

hasError ()

Reads out a function call's success.

bool hasError()

Returns true Means: call success. Use getResult () to read out the value.

false Means: call failure. Use getError () to read out the value.

getError ()

Reads out the reason if a function call fails.

bool getError()

Returns const string
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result ()

The following functions aid in defining the exact results:

Result(string errorString_)

Result(NlcErrorCode errCode, string errorString_)

Result(NlcErrorCode errCode, uint exErrCode, string errorString_)

Result(NanotecException exception)

Result(Result result)

getErrorCode () const

NlcErrorCode getErrorCode()

getExErrorCode () const

uint32_t getExErrorCode () const

uint getExErrorCode() 

7.19.1 ResultVoid
NanoLib sends you an instance of this class if the function returns void. This class inherits the public
functions and protected attributes from the result class and has the following public member functions:

ResultVoid ()

The following functions aid in defining the exact void result:

ResultVoid(string errorString_) 

ResultVoid(NlcErrorCode errCode, string errorString_) 

ResultVoid(NlcErrorCode errCode, uint exErrCode, string errorString_) 

ResultVoid(NanotecException exception) 

ResultVoid(Result result) 

7.19.2 ResultInt
NanoLib sends you an instance of this class if the function returns an integer. This class inherits the public
functions and protected attributes from the result class and has the following public member functions:

getResult ()

Reads out the integer result if a function call had success.

long getResult() 

Returns long
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ResultInt ()

The following functions aid in defining the exact integer result:

ResultInt(long result_) 

ResultInt(string errorString_) 

ResultInt(NlcErrorCode errCode, string errorString_) 

ResultInt(NlcErrorCode errCode, uint exErrCode, string errorString_) 

ResultInt(NanotecException exception) 

ResultInt(Result result)

7.19.3 ResultString
NanoLib sends you an instance of this class if the function returns a string. This class inherits the public
functions and protected attributes from the result class and has the following public member functions:

getResult ()

Reads out the string result if a function call had success.

string getResult()

Returns const string

ResultString ()

The following functions aid in defining the exact string result:

ResultString(string message, bool hasError_)

ResultString(NlcErrorCode errCode, string errorString_)

ResultString(NlcErrorCode errCode, uint exErrCode, string errorString_)

ResultString(NanotecException exception)

ResultString(Result result)

7.19.4 ResultArrayByte
NanoLib sends you an instance of this class if the function returns a byte array. This class inherits the public
functions and protected attributes from the result class and has the following public member functions:

getResult ()

Reads out the byte vector if a function call had success.

ByteVector getResult()

Returns const vector<uint8_t>
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ResultArrayByte ()

The following functions aid in defining the exact byte array result:

ResultArrayByte(ByteVector result_)

ResultArrayByte(string errorString_)

ResultArrayByte(NlcErrorCode errCode, string errorString_)

ResultArrayByte(NlcErrorCode errCode, uint exErrCode, string errorString_)

ResultArrayByte(NanotecException exception)

ResultArrayByte(Result result)

7.19.5 ResultArrayInt
NanoLib sends you an instance of this class if the function returns an integer array. This class inherits the
public functions and protected attributes from the result class and has the following public member functions:

getResult ()

Reads out the integer vector if a function call had success.

IntVector getResult()

Returns const vector<uint64_t>

ResultArrayInt ()

The following functions aid in defining the exact integer array result:

ResultArrayInt(IntVector result_)

ResultArrayInt(string errorString_)

ResultArrayInt(NlcErrorCode errCode, string errorString_)

ResultArrayInt(NlcErrorCode errCode, uint exErrCode, string errorString_)

ResultArrayInt(NanotecException exception)

ResultArrayInt(Result result)

7.19.6 ResultBusHwIds
NanoLib sends you an instance of this class if the function returns a bus-hardware-ID array. This class
inherits the public functions and protected attributes from the result class and has the following public
member functions:

getResult ()

Reads out the bus-hardware-ID vector if a function call had success.

BusHWIdVector getResult()
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Parameters const vector<BusHardwareId>

ResultBusHwIds ()

The following functions aid in defining the exact bus-hardware-ID-array result:

ResultBusHwIds(BusHWIdVector result_)

ResultBusHwIds(string errorString_)

ResultBusHwIds(NlcErrorCode errCode, string errorString_)

ResultBusHwIds(NlcErrorCode errCode, uint exErrCode, string errorString_)

ResultBusHwIds(NanotecException exception)

ResultBusHwIds(Result result)

7.19.7 ResultDeviceId
NanoLib sends you an instance of this class if the function returns a device ID. This class inherits the public
functions and protected attributes from the result class and has the following public member functions:

getResult ()

Reads out the device ID vector if a function call had success.

DeviceId getResult()

Returns const vector<DeviceId>

ResultDeviceId ()

The following functions aid in defining the exact device ID result:

ResultDeviceId(DeviceId result_)

ResultDeviceId(string errorString_)

ResultDeviceId(NlcErrorCode errCode, string errorString_)

ResultDeviceId(NlcErrorCode errCode, uint exErrCode, string errorString_)

ResultDeviceId(Result result)

7.19.8 ResultDeviceIds
NanoLib sends you an instance of this class if the function returns a device ID array. This class inherits the
public functions and protected attributes from the result class and has the following public member functions:

getResult ()

Returns the device ID vector if a function call had success.

DeviceIdVector getResult()

Returns const vector<DeviceId>
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ResultDeviceIds ()

The following functions aid in defining the exact device-ID-array result:

ResultDeviceIds(DeviceIdVector result_)

ResultDeviceIds(string errorString_)

ResultDeviceIds(NlcErrorCode errCode, string errorString_)

ResultDeviceIds(NlcErrorCode errCode, uint exErrCode, string errorString_)

ResultDeviceIds(NanotecException exception)

ResultDeviceIds(Result result)

7.19.9 ResultDeviceHandle
NanoLib sends you an instance of this class if the function returns the monitoring outcome of a device handle.
This class inherits the public functions and protected attributes from the result class and has the following
public member functions:

getResult ()

Reads out the device handle if a function call had success.

Nlc.DeviceHandle  getResult()

Returns DeviceHandle

ResultDeviceHandle ()

The following functions aid in defining the exact device handle result:

ResultDeviceHandle( Nlc.DeviceHandle  result_)

ResultDeviceHandle(string errorString_)

ResultDeviceHandle(NlcErrorCode errCode, string errorString_)

ResultDeviceHandle(NlcErrorCode errCode, uint exErrCode, string errorString_)

ResultDeviceHandle(NanotecException exception)

ResultDeviceHandle(Result result)

7.19.10 ResultConnectionState
NanoLib sends you an instance of this class if the function returns a device-connection-state info. This
class inherits the public functions and protected attributes from the result class and has the following public
member functions:

getResult ()

Reads out the device handle if a function call had success.

DeviceConnectionStateInfo getResult()
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Returns DeviceHandle

ResultConnectionState ()

The following functions aid in defining the exact connection state result:

ResultConnectionState(DeviceConnectionStateInfo result_)

ResultConnectionState(string errorString_)

ResultConnectionState(NlcErrorCode errCode, string errorString_)

ResultConnectionState(NlcErrorCode errCode, uint exErrCode, string
 errorString_)

ResultConnectionState(NanotecException exception)

ResultConnectionState(Result result)

7.19.11 ResultObjectDictionary
NanoLib sends you an instance of this class if the function returns the monitoring outcome of an object dic-
tionary. This class inherits the public functions and protected attributes from the result class and has the fol-
lowing public member functions:

getResult ()

Reads out the device ID vector if a function call had success.

ObjectDictionary getResult()

Returns const vector<DeviceId>

ResultObjectDictionary ()

The following functions aid in defining the exact object dictionary result:

ResultObjectDictionary(ObjectDictionary result_)

ResultObjectDictionary(string errorString_)

ResultObjectDictionary(NlcErrorCode errCode, string errorString_)

ResultObjectDictionary(NlcErrorCode errCode, uint exErrCode, string
 errorString_)

ResultObjectDictionary(NanotecException exception)

ResultObjectDictionary(Result result)

7.19.12 ResultObjectEntry
NanoLib sends you an instance of this class if the function returns an object entry. This class inherits the pub-
lic functions and protected attributes from the result class and has the following public member functions:
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getResult ()

Returns the device ID vector if a function call had success.

ObjectEntry getResult()

Returns const vector<DeviceId>

ResultObjectEntry ()

The following functions aid in defining the exact object entry result:

ResultObjectEntry(ObjectEntry result_)

ResultObjectEntry(string errorString_)

ResultObjectEntry(NlcErrorCode errCode, string errorString_)

ResultObjectEntry(NlcErrorCode errCode, uint exErrCode, string errorString_)

ResultObjectEntry(NanotecException exception)

ResultObjectEntry(Result result)

7.19.13 ResultObjectSubEntry
NanoLib sends you an instance of this class if the function returns an object sub-entry. This class inherits the
public functions and protected attributes from the result class and has the following public member functions:

getResult ()

Returns the device ID vector if a function call had success.

ObjectSubEntry getResult()

Returns const vector<DeviceId>

ResultObjectSubEntry ()

The following functions aid in defining the exact object sub-entry result:

ResultObjectSubEntry(ObjectSubEntry result_)

ResultObjectSubEntry(string errorString_)

ResultObjectSubEntry(NlcErrorCode errCode, string errorString_)

ResultObjectSubEntry(NlcErrorCode errCode, uint exErrCode, string
 errorString_)

ResultObjectSubEntry(NanotecException exception)

ResultObjectSubEntry(Result result)
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7.20 NlcCallback

This parent class for callbacks has the following public member function:

callback ()

virtual ResultVoid callback()

Returns ResultVoid

7.21 NlcDataTransferCallback

Use this callback class for data transfers (firmware update, NanoJ upload etc.).

1. For a firmware upload: Define a class extending this one with a custom callback method implementation.
2. Use the new class's instances in NanoLibAccessor.firmwareUpload () calls.

The class has the following public member function:

callback ()

virtual ResultVoid callback(DataTransferInfo info, int data)

Returns ResultVoid

7.22 NlcScanBusCallback

Use this callback class for bus scanning.

1. Define a class extending this one with a custom callback method implementation.
2. Use the instances of the new class in NanoLibAccessor.scanDevices () calls.

The class has the following public member function.

callback ()

virtual ResultVoid callback(BusScanInfo info, DeviceIdVector devicesFound, int
 data)

Returns ResultVoid

7.23 Serial

Find here your serial communication options and the following public attributes:

:string BAUD_RATE_OPTIONS_NAME = "serial baud rate"

SerialBaudRate baudRate = SerialBaudRate ()

string PARITY_OPTIONS_NAME = "serial parity"

SerialParity parity = SerialParity ()

7.24 SerialBaudRate

Find here your serial communication baud rate and the following public attributes:

string BAUD_RATE_7200 = "7200"

string BAUD_RATE_9600 = "9600"

string BAUD_RATE_14400 = "14400"
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string BAUD_RATE_19200 = "19200"

string BAUD_RATE_38400 = "38400"

string BAUD_RATE_56000 = "56000"

string BAUD_RATE_57600 = "57600"

string BAUD_RATE_115200 = "115200"

string BAUD_RATE_128000 = "128000"

string BAUD_RATE_256000 = "256000"

7.25 SerialParity

Find here your serial parity options and the following public attributes:

string NONE = "none"

string ODD = "odd"

string EVEN = "even"

string MARK = "mark"

string SPACE = "space"

7.26 NanotecException classes

Check these classes if an operation went wrong due to time-outs or illogical / invalid addresses, arguments,
protocols, resources etc. Class functions are:

NanotecException(string msg, NlcErrorCode errCode, uint exErrCode)

virtual string what()

NlcErrorCode getErrorCode()

uint getExErrorCode()

7.26.1 AbortException
If an operation stalls, use this class to override the abort mechanism. The class offers the function
AbortException(string message, uint abortCode)
. From NanotecException, it also inherits the following public functions:

NanotecException(string msg, NlcErrorCode errCode, uint exErrCode)

virtual string what()

NlcErrorCode getErrorCode()

uint getExErrorCode()
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7.26.2 InvalidAddressException
If an object dictionary address is wrong, use this class to address the object correctly. The class offers the
function InvalidAddressException(string message). From NanotecException, it also inherits the
following public functions:

NanotecException(string msg, NlcErrorCode errCode, uint exErrCode)

virtual string what()

NlcErrorCode getErrorCode()

uint getExErrorCode()

7.26.3 ProtocolException
Use this class on unexpected messages from the counterpart (= firmware etc.), or on unfullfilled precondi-
tions, to meet the protocol. The class offers the function ProtocolException(string message). From
NanotecException, it also inherits the following public functions:

NanotecException(string msg, NlcErrorCode errCode, uint exErrCode)

virtual string what()

NlcErrorCode getErrorCode()

uint getExErrorCode()

7.26.4 ResourceException
Use this class to fix errors with required local resources, CAN adapters etc. The class offers the function
ResourceException(string message). From NanotecException, it also inherits the following public
functions:

NanotecException(string msg, NlcErrorCode errCode, uint exErrCode)

virtual string what()

NlcErrorCode getErrorCode()

uint getExErrorCode()

7.26.5 TimeoutException
If a certain period exceeds (say, a 100 ms time-out for CANopen / Modbus), you can use this class to
change or end the time-out. The class offers the function TimeoutException(string message). From
NanotecException, it also inherits the following public functions:

NanotecException(string msg, NlcErrorCode errCode, uint exErrCode)

virtual string what()

NlcErrorCode getErrorCode()

uint getExErrorCode()
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The NanoLib interface (API) and the example source code provided are licensed by Nanotec Electronic
GmbH & Co. KG under the Creative Commons Attribution 3.0 Unported License (CC BY). The parts of the
library provided in binary format (core and fieldbus communication libraries) are licensed under the Creative
Commons Attribution-NoDerivatives 4.0 International License (CC BY ND).

Creative Commons

The following human-readable summary does not substitute the license(s) itself. You can find the respective
license at creativecommons.org and linked below. You are free to:

CC BY 3.0 CC BY-ND 4.0

■ Share: See right.
■ Adapt: Remix, transform, and build upon the

material for any purpose, even commercially.

■ Share: Copy and redistribute the material in any
medium or format.

The licensor cannot revoke the above freedoms as long as you obey the following license terms:

CC BY 3.0 CC BY-ND 4.0

■ Attribution: You must give appropriate credit,
provide a link to the license, and indicate if
changes were made. You may do so in any
reasonable manner, but not in any way that
suggests the licensor endorses you or your use.

■ No additional restrictions: You may not apply
legal terms or technological measures that legally
restrict others from doing anything the license
permits.

■ Attribution: See left. But: Provide a link to this
other license.

■ No derivatives: If you remix, transform, or build
upon the material, you may not distribute the
modified material.

■ No additional restrictions: See left.

Note: You do not have to comply with the license for elements of the material in the public domain or where
your use is permitted by an applicable exception or limitation.

Note: No warranties given. The license may not give you all of the permissions necessary for your intended
use. For example, other rights such as publicity, privacy, or moral rights may limit how you use the material.
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© 2021 Nanotec Electronic GmbH & Co. KG. All rights reserved. No portion of this document to be repro-
duced without prior written consent. Specifications subject to change without notice. Errors, omissions, and
modifications excepted. Original version.

Nanotec Electronic GmbH & Co. KG │ Kapellenstraße 6 │ 85622 Feldkirchen │ Germany

Tel. +49 (0)89 900 686-0 │ Fax +49 (0)89 900 686-50 │ info@nanotec.de │ www.nanotec.com

Document Changes Product
release

1.0.0 (06/2021) Edition 0.7.0

1.0.1 (11/2021) ■ More ObjectEntryDataType (complex and profile-specific)
■ IOError return if connectDevice and scanDevices find none
■ Only 100 ms nominal timeout for CanOpen / Modbus
■ Added OdTypesHelper class

0.7.1
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